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What’s On .. General Meeting – Thursday 1 March 2012, 3pm at Buderim
Technology
Education
Centres
Caloundra
Buderim
Yandina

• Get hands on help with all your technology problems.
• Tutorials are presented during each session.
• Internet and Intranet access is available.
Windows, Linux and Apple Mac operating systems are supported.
Every Saturday between 9.00 am and 12.30 pm
Caloundra Youth hall, Queen Street Caloundra, (opposite High School).
Every Thursday between 1pm to 4pm
Good Life Centre, 100 Buderim Pines Drive, Buderim.
3rd Wednesday of the month between 1.30 pm and 4.00 pm.,
RSL Hall, North Street, Yandina

Notice about SCCC Monthly General Meetings
The SCCC Monthly Meetings alternate between the Caloundra and Buderim venues. In Caloundra the meeting is held on the first
Saturday of the month and in Buderim the meeting is held on the first Thursday of the alternate month.

The next SCCC Monthly Meeting will be at Buderim on Thursday 1 March 2012.

Page 1

Bits'N'Bytes

March 2012

From The Editor – Treasurer's Report
Bits'N'Bytes is produced monthly from February to
December each year.
Contributions for the newsletter are always welcome.
Please send copy for the next issue to reach the editor
as early as possible after the monthly meeting or by the
deadline: 20 March 2012.
Email: editor@sccc.org.au or Snail Mail: The Editor PO
Box 384, Caloundra, Qld 4551.

Membership Cards for Collection - Membership
cards for those members who joined or renewed
membership for the month ending 20 February2012 are
available for collection at Caloundra and Buderim
meetings. Cards that have not been collected in the
previous twelve months are also available.
Note - Membership cards show the next renewal date
of membership.

This magazine is created with OpenOffice and
produced in printed form and also electronically
in PDF format.
Copyright - material in this newsletter may be copied
in other publications provided that copyright rests with
the Sunshine Coast Computer Club Inc., This permission
is on condition that reference is made to SCCC (with
original published date) in the reprinted item.
Liability - Although articles in this newsletter are
checked for content, no warranty can be given for any
loss resulting from the use of material in the newsletter.
Articles and advertisements are printed in good faith
and views and opinions are not necessarily those held
by the club.
SCCC Privacy Statement - In joining the Sunshine
Coast Computer Club please note that it is a club
operated by volunteer members and operating within
the community involving many activities relating to
meetings, instructional and social functions for
members and at times visitors.
This requires the keeping of a member data base and
the publication of the names of new members. The
Club guards the member data base as best as possible
and does not publish member's addresses nor
telephone numbers unless authorised.
At times photographs are taken at meetings and
functions and are sometimes published. Should you
have any problems relating to your personal privacy
which arises or is likely to arise, it is your duty and
responsibility to advise the Club secretary in writing of
the circumstances and requirements.

Treasurer's Report
Profit and Loss
21 January 2012 – 20 February 2012
Income
Fundraising
Interest Received
Meetings
Membership fees
Sales
Total Income
Expense
Administration
Fundraising Expense
Hall Hire
Internet Service Provider
Lanyards
Postage
Printing/Stationery
Refreshments
Sundry Equipment
Repairs & Replacements
Total Sundry Equipment
Travel Reimbursement
Total Expense
Net Income

What's on Bulletin - What's On Bulletins are sent once
a week, generally on a Monday afternoon, to all members
who have provided the Club with their email address.
These bulletins give details of up-coming tutorials and
topics to be covered at the various meeting venues. You
will also find items of interest and club announcements in
these bulletins.
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611.00
484.74
2,640.00
3,348.00
10.00
7093.74

200.00
281.14
1,408.50
39.95
536.95
137.68
278.00
484.12
50.87
50.87
35.52
3,452.75
3641.01
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Minutes of annual General Meeting
Minutes of the Sunshine Coast Computer Club
Annual General Meeting
Held at the Caloundra Community Youth Hall
Queen Street Caloundra
4th February 2012
Peter Daley declared the meeting open at
10.15am

Committee
Member

Tom Bray

477 Morry Phillips

Committee
Member

Andrew
Hadland

102 Peter Daley
9

Committee
Member

Trevor Jones

143 Marie McGregor

Administrativ Jean Lear
e
Coordinator/
Committee
Member

122

Peter Daley

Committee
Member

George Lupsa

731

Nevil Eyre

Committee
Member

Jim McGregor

209 Hermine
Kuepper

He then requested the out going committee to come
forward, and introduced them. He called for a vote of
thanks to the out going committee for a great effort
during the past year. He nominated Peter Dodwell,
Morry Phillips and Tom Bray for life membership and a
special thank you to Heather Atkinson, who for many
years has tirelessly served as Treasurer and Editor of
the Bits'N'Bytes, and has run the Buderim centre, but
this year is not standing for office.

Committee
Member

Morris Phillips

94

Committee
Member

Judy Smith

278 Jean Lear
6

Committee
Member

Ian Smyth

201 Don Wallace
2

Committee
Member

Don Wallace

120 Ian Smyth
0

Peter then requested that Trevor Jones take the chair.
Trevor declared all positions vacant. He also called for a
vote of thanks for Peter Daley for the great job he does
as president of the club.

Committee
Graham Weeks 290 Morry Phillips
Member
5
The two unsuccessful nominations were George Lupsa
and Graham Weeks.

Previous Minutes: No business arising from the
previous minutes, A Motion that the minutes be
accepted was proposed by Jean Lear
and
seconded by Hermine Kuepper CARRIED
Presidents Report Peter Daley opened the AGM for
2012. Peter announced that it had been a very good
year, everything had run very smoothly, we have
approximately $20, 000 in the bank. His full report was
published in the February 2012 edition of Bits'N'Bytes.

Trevor read out the nominations for President, Vice
President and Secretary, who were all returned
unopposed. No one nominated for Treasurer, and Trevor
asked if any one would consider nominating for this
position. Trevor introduced the eleven people
nominated for positions on the committee, and as only
nine committee members are allowed, according to the
Constitution, it was necessary to hold a ballot for the
vacant positions.
Position

Nominee

M/s Nominated by
hip
No

President

Peter Daley

26

Trevor Jones

Vice
President

Peter Dodwell

19

Leslie Power

Treasurer
Secretary

Marie McGregor 209 Hermine
Kuepper

Tom Bray

At the close of the meeting Brian Davies and Chris
Phillips both nominated for Treasurer. Brian withdrew
his nomination and Chris Phillips was accepted as
Treasurer. Trevor Jones resigned his nomination on the
committee in favour of George Lupsa.
The New Committee comprises: President: Peter
Daley. Vice President: Peter Dodwell. Treasurer:
Chris Phillips.
Secretary: Marie McGregor.
Administrator/Committee Member: Jean Lear.
Committee Members: Tom Bray: Andrew
Hadland; George Lupsa; Jim McGregor; Morry
Phillips; Judy Smith; Ian Smyth; Don Wallace.
Trevor handed over to Peter Daley and stepped down.
Treasurers Report: The Outgoing Treasurer Leo
Kavanagh presented the financial report and the
auditors report. Leo said we had a good report back
from the auditors, with no complaints. We currently
have $21,671.20 in 3 separate accounts.

Continued Page 4
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Minutes of Annual General Meting - Continued
Continued from page 3
The full auditors report and the monthly financial report
are published on the clubs website, in the members
only pages, and members must be registered to access
them. The Financial report was also published in
February's Bits'N'Bytes
Proposed by Leo Kavanagh and seconded by
Tony Tasker that the Treasurers report and the
auditors report be accepted CARRIED
New Members: Jean Carroll, Mary Gilchrist, Bev
Higgins, Terrance Morrish, Richard Airs, Christa Balk,
Garry and Gloria Berry, George Coffin, Judy Crofts, Tony
Ernst, Karl Kohl. Carol McAree, Ray Nicholson, Stephen
Ormerod, Dorothy Peake, Jan Shaw, Santo Torcello, Bill
Van Motman, Maureen Wallace, Marilyn Wilson.

•

Peter advised that the committee would review
the situation in a few months and if the things
had not improved would consider going back to
renting one room at Buderim. He then called
the meeting to a close.

Meeting Closed at 11.20am
Marie McGregor - Secretary.

General Business :
•

A Motion was proposed by Peter Daley
and Seconded by Daphne McGrath to give
life membership to Tom Bray, Peter
Dodwell, and Morry Phillips CARRIED

•

Peter Dodwell moved a Motion of
appreciation from the club to outgoing
Treasurer Leo Kavanagh who has done an
excellent job, during his tenure of office,
this was seconded by Ian Smyth
CARRIED.

•

Raising Membership Fees. Peter said there
was a motion being considered by the
committee to raise membership fees by $10
across the board. This was due to rising costs
for hall hire, auditors fees, insurance and
general expenses. One of our major problems
is the Good Life Centre at Buderim, where we
rented extra rooms last year, but attendance
dropped off, and rent was increased by 15%.
Various other suggestions that were being
considered were to try to increase membership,
by promotion and advertising, and get more
people to attend Buderim, or to increase door
fees, or finally to relinquish the extra space at
Buderim. We had already delayed buying new
equipment. Peter told the members present
that membership fees had not increased since
2002, which is pretty good for any club.

•

Ian Smyth proposed a motion to increase
membership fees by $10 across the board
straight away this was seconded by Max
Braddock. CARRIED

Letters must be dated, and include the full name and
membership number of the writer. Letters should be
concise and preference will be given to letters of 200
words or less.
email: editor@sccc.org.au or
Snail Mail: The Editor PO Box 384, Caloundra, Qld 4551.
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Is it time to stop travelling to the Northern Hemisphere? – Peter Daley
There are increasing independent reports coming in
from people with radiation testing equipment that is
strongly suggesting that travelling to certain areas in
the Northern Hemisphere could be a serious risk to you
and your family's health. I know a lot of members
travel, that is why I have written this article. Study the
information in the articles provided, and do further
research before making travel arrangements. It could
mean the difference between life and death for you or a
family member. Radiation fallout will not kill you
instantly, but depending on the internal and/or external
doses, it can considerably shorten one's life.
Last year the Japanese tourist industry was offering ten
thousand free flights to Japan. They said that the
Fukushima nuclear disaster was under control, and
that is was now safe to travel there, as long as you
stayed outside of the Fukushima Nuclear Disaster
exclusion zone. The evidence provided here strongly
suggests otherwise.
This very recent February 25th 2012 independent
report shows a recording of 6.5 uS/Hr background level
of radiation at Tokyo Station. For those who don't
understand what 6.5 uS/Hr means, it is 65 times higher
than our average local background, and ten times
Chernobyl mandatory evacuation level. At this level, it
should also be a mandatory evacuation zone, the
same as the Fukushima nuclear disaster zone!
Tokyo railway station is a railway station in the
Marunouchi business district of Chiyoda. Tokyo station
is near the Imperial Palace grounds and the Ginza
commercial district. It is the main intercity rail terminal
in Tokyo, the busiest station in Japan in terms of
number of trains per day, with over 3,000 trains per
day, and the fifth-busiest in Eastern Japan in terms of
passenger numbers.
Tokyo railway station has tens of thousands of men,
women and children travelling through it daily. It means
that a lot of radioactive dust has been transported from
contaminated areas by travellers and it is also being
stirred up as they move through the station.
Ingested radiation from contaminated food,
liquids or air, radiates body cells with high doses
of radiation for long periods of time. Radioactive
dust breathed in is very dangerous because if it gets
stuck in you lungs, it will irradiate the cell it is next to,
and those around, it with high doses of radiation, and
you can't walk away from it. Unlike a piece of radiation
that maybe lying on the ground. So this is a very
serious health issue for anyone travelling through, or
working at the station.

Is it now necessary to own a Geiger Counter and learn
how to use it properly, if you intend travelling overseas?
This is a question some of you may have to ask. I will
be available to show you how to use a Geiger counter
at club meetings, for those who are interested.
Read the full article here.
http://enenews.com/report-6-5-microsvh-at-japansbusiest-train-station-equal-to-57-millisieverts-per-year10-times-chernobyl-evacuation-levels-near-imperialpalace-photos
Are aircraft flights across the Northern
Hemisphere also becoming very risky?
All the evidence is suggesting that a lot of the fallout
from Fukushima Nuclear disaster is still being released
into the upper atmosphere in the Northern Hemisphere.
When planes fly through this higher atmosphere, the
radioactive fallout cloud is sucked into the cabin of the
aircraft, together with radioactive hot particles.
This article by By Michael Collins, EnviroReporter.com
documents a flight across America on December 23rd
2011. The big differences between him and his new
wife, and the normal passengers, was that they took a
Geiger counter and also wore respirators.
Hot particles where detected on their respirators at the
end of the flight. Also they had readings as high as
1,238 CPM in flight, or over 36 times higher than the
background radiation in the jet, at the terminal. This
article clearly shows the dangers in travelling by air in
the Northern Hemisphere at present. Pregnant women
or small children are much more sensitive to the effects
of radiation. So it is important that your family becomes
fully aware of the risks of travelling overseas at present.
If they are not aware of the risk, they can't take action
to protect themselves.
http://www.enviroreporter.com/2012/01/seasonsreadings/
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Training Session 12 – Macintosh- Preview Part 2 – Ian Stringer
In this Training Session, we explore the Preview
application menu bar. Click on Preview to show its
drop-down menu. About Preview shows the version
of the Application. This applies to all native Apple
Applications. We looked at Preview Preferences…
in Training Session 11.
Open any image, click on the File drop-down menu,
and note its many keyboard shortcuts (the greyed-out
options are not available). Open Recent is useful. With
Save As..., (⇧⌘S) you can change the Format: of
your image (click on the up-down arrows to see the
options), and its Quality: (slide from Least to Best
and see the File Size: change. Give the file a name
and choose where to save it. This File drop-down menu
is where you also find the Print… (⌘P) command.
Have a look at the Edit drop-down menu, is similar
across many Apple Applications. Have a look at the
many options available in the View drop-down menu;
many replicate the action of other tools. Have a look at
Customize Toolbar…; you can add tools if you want
to. Be prepared to explore these options to discover
what they do. The Go menu is brief.
The Tools drop-down menu offers very powerful
options to modify your images. Explore Show
Inspector and Show Fonts. (Fonts should be a
Training Session in its own right.) With an image open,
click on Adjust Color… (⌥⌘C). This opens an Adjust
Color pane with many features. The top is a graph of
the colours in the image. Watch your image as you click
on the Auto Levels button. This should correct major
exposure errors. You can also tweak the Exposure:,
Contrast:, Saturation:, Temperature:, Tint:,
Sepia: and finally Sharpness:. Best to try all these to
see what they do. Notice the Reset All button at the
bottom of this pane; you haven’t irreversibly altered
your image! Close the Adjust Color pane.

based on type font sizes. Such images look good on a
computer screen, but are not good enough to print out
on paper. So if you intend to print out your image,
change the 72 to at least 200, better is 300 (dots/inch
on your printer). Clicking the Scale proportionally
button will unlock/lock the padlock. Resample
image calculates the file size for your Fit into: setting.
The resulting size of your image is shown in the lower
panel. So, for example, using Fit into: 640x480
(postcard size) and 300 pixels/inch will give a file size of
24 percent and 81 kB (was 1.4 MB). If this is not
what you want, click the Cancel button.
Back in the Tools drop-down menu, the next four
options replicate the Move Tool, Text Tool, Select
Tool and the Annotate choices that are in the
toolbar. Then there are four actions for rotating and
flipping your image. Rotate Left (⌘L), Rotate Right
(⌘R), Flip Horizontal and Flip Vertical (no
shortcuts). If your image is not level, you cannot
straighten it in Preview; you need to put it into
iPhoto and use the Straighten tool there, then bring
it into Preview.
The Crop command (⌘K) is very useful, and works
with the Select Tool. You can crop any shape and also
delete parts of your image.

Assign Profile… deals with the way a printer needs to
be set up to print the required colours - very advanced.
I’m not sure how to use Bookmarks, and the
Window drop-down menu is self explanatory.
The Help drop-down menu will take you to Preview
Help where you can explore a wide range of related
topics.
Training Session 12 - Macintosh - Preview Part 2
© Ian Stringer 19 February 2012

Back in the Tools drop-down menu click on Adjust
Size… . This Image Dimensions pane is where you
can adjust the size of your image. Fit into: lets you
select the pixels for your screen. Width: and Height:
are locked with a padlock, which keeps the proportion
of the image. You can unlock the padlock and change
the proportions of your image. You can chose the units
by clicking on the up-down arrows on the right-hand
side. These let you resize your image to whatever size
you want, keep it in proportion or not, and set the size
units. (I have used 6.3 mm for photos to be printed in a
book, better than shrinking down 2 MByte pictures to
fit, that stayed at 2 MByte!)

Resolution will be 72 pixels/inch; the historical
number of pixels on early computer screens, which was
Page 6
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Technician's Diary – Peter Dodwell
Preparing for the coming Windows Armageddon - when
support for XP (or other versions)
runs out. Please note that the
suggested measures to extend the
useful life of your operating system
have an added benefit. You will
ensure the integrity of your system
as well as the safety of your precious
data. Altho' I'm focussing primarily on XP, these notes
apply equally to Vista & 7.

http://www.passmark.com/products/diskchecku
p.htm. Also, run chkdsk.exe to test the
integrity of your storage system. Open `My
Computer' then right click on the c drive. In
properties/tools you'll find the menu item
`check drive for errors'. When you run this, it'll
tell you to restart your machine so that the
program can run before anything else starts.

XP's main stream & service pack support has already
expired, and extended service has only a couple of
years to run. Vista's service pack support has expired,
and mainstream support will end this April. Extended
support still has a few years left. With 7, service pack
support will end in April next year, but both mainstream
& extended support still have a few years left.
Your system won't suddenly stop running when support
dries up. Far from it. It will still have a number of years
useful life. The plus side is that you'll be able to keep
using your current programs and hardware. Many of
those who run Windows 7 can testify that it won't run
some older programs
or no drivers available for
perfectly good older hardware. The flip side is that any
newer software or hardware may not be usable on
older equipment.

•

Make sure that your drivers are current.
SlimDrivers, a free program available from
http://majorgeeks.com/SlimDrivers_d6737.html
can automatically find & install updated drivers
for your system. Use Double Driver (also from
MajorGeeks) to backup or restore your drivers.

•

Patch & update your system & apps. Use
Secunia's free PSI (from MajorGeeks) to
monitor your system & advise when system or
program updates are necessary. .

•

Use Ccleaner to get rid of unnecessary files.
Also, uninstall any programs that you no longer
or rarely use. Revo is an excellent free program
for this. Finally, use Smart Defrag 2 to defrag
your hard drive, & PageDefrag to optimize your
registry. Also from MajorGeeks.

•

Get a second opinion on your security by using
a free online malware/virus scanner. Trend
Micro's `Housecall' is a reasonable one. But
there are others which you can find by
Googling. Microsoft Safety Scanner is a free
download which one burns to a Cd. It runs live
when you boot from the CD, and updates itself
before scanning. The benefit is that it runs
without activating any malware which may be
present. Go to www.grc.com to test your
firewall with their free online `Shields Up'
service.

•

Finally, backup regularly any precious data files,
and use a disk imaging program 2 or 3 times a
year (or whenever you make a major change)
to create an exact mirror image of your system
so that it can be reinstalled exactly the way it
was in the event of a disaster. It is best to store
this on a separate dedicated external hard
drive. Be aware that any reinstall must be on a
system that is substantially the same as the
original, or you could have problems with
Windows needing to be reactivated.

As previously noted, the following measures will not
only help to extend the life of your operating system,
but also its integrity and the safety of your data in the
event of an inevitable system crash.
•

Check the hardware. Your system is only as
good as the hardware on which it runs. Open
the case and check for dust. This can cause the
CPU & drives to malfunction because of
overheating. Use a canister of compressed air
from an electronics shop, as well as some soft
brushes to clean the machine's innards. I use a
1”paint brush and a couple of artist's brushes
for this. An important point: leave the computer
connected to the power supply so that you can
`earth' yourself by touching some bare metal
prior to working inside the case. Static
electricity can deep fry your chips.
Make sure that any plug in cards (video, etc)
are correctly seated, and cables firmly
connected.

•

Check your hard drive's health. Most drives
have a `smart' monitoring system which stores
data on the drive itself. This can easily be
accessed & read by PassMark's free
DiskCheckup program, obtainable from -

If you practice regularly these steps you will be wellplaced to keep your version of Windows running
efficiently well beyond its use by date, and/or survive
any disaster.
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Bits and Pieces
Continued from page 5

Stay Smart Online Alert Service Newsletter

Is it time to stop travelling to the Northern
Hemisphere? – Peter Daley

The newsletter provides general advice about online
security issues and help to better manage the security
of your computer while online.

These articles suggest that travel hubs are becoming
concentrators of radioactive fallout carried around by
people travelling through them. Again it is the ingested
radiation that is the most dangerous, because you can't
get away from it.
I personally suggest to stay healthy and well in the long
term, everyone eat local food, avoid food grown in the
Northern Hemisphere, and travel locally. Try as best you
can to educate your families to the present risks, as
there is no main stream media reporting of this issue.

The February newsletter covers PDF security, including
securing Adobe Reader, alternative PDF software, and
how to avoid having your iTunes account hacked
Find the February edition here:
http://www.ssoalertservice.net.au/content/doc/Februar
y2012.pdf

I would like to point out again that the people in these
reports are using radioactive testing equipment that
clearly shows what they are reporting is true. So there
is strong psychical evidence to back up what they are
saying!
This article is my opinion and does not necessarily
represent that of the club.

Free 'How To' Classes in store or online
See Peter Blasina, The Gadget Guy's 'How To' videos at:
http://www.officeworks.com.au/retail/landing/gadget_g
uy_video
For details of In Store Classes go to:
http://www.officeworks.com.au/ims_docs/static/ht_que
ensland.pdf

Sunshine Coast Libraries
For things to do at the library go to:
http://www.sbm21.com/SunshineCoastRegionalCouncil/
files/latest_edition.html
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Why Linux, Whose Penguin? - Gerry Clarke
Why would I bother with a new operating system such
as Linux when the Windows systems provided with my
computers allow me to do almost everything I need?
Well, there are a few good reasons for taking Linux
seriously. The operating system is free to download; it's
updates are also free and as regular as I choose; I
don’t have to worry about virus protection; I have a
choice of free software from thousands of application
programs almost equal to or better than those which
Windows allows me to buy; I don’t have to remember
to defrag regularly because Linux does it for me
automatically; most importantly, apart from saving
many hundreds of dollars for software and periodic
upgrades I feel more in control of my computer.
There are more than 600 Linux Distributions (See
www.distrowatch.com). Reading the release notes of
many of these “distros” can be confusing and its best
to simply choose one which someone else you know is
using so that you can help each other as you learn
more about the Linux system and how to configure
and troubleshoot your installation. The Linux group in
the club has chosen to standardise on Mandriva
Linux as a preferred system for this reason. A few
club members are in addition to Mandriva using
similar systems including PCLinuxOS, Mageia, Ubuntu,
and Mint.
For today's desktop and laptop computers, the most
popular Linux distributions by demand are those that
provide the user with a comfortable migration path
from Windows using a graphical user interface (GUI),
accessible with a palm held “mouse”, or with a laptop
fingerpad. Also, most distros provide user access to the
command language via the konsole or terminal.
Windows does include access to a command language
but does not encourage the average user to get
involved. The Linux providers invite you to get involved
at a deeper level so that you can contribute back to the
development cycle as your expertise grows or otherwise
to understand your computer better.
In choosing a linux operating system you need to
consider the following: What do you want to use your
computer for? e.g. word-processing, email, web
browsing (for education, research, or downloading
podcasts or videos). Almost any of the popular distros
include these basic facilities. Do you want to manage
and manipulate digital photos, restore old photos, or
edit videos? Do you want to use Skype for internet
telephone/video

You will need to check that your printer is compatible
with the version of Linux you choose to install. The
printing manufacturers who have been most helpful in
providing drivers to achieve successful marriages in this
respect are Hewlett Packard and Brother. You might be
lucky, depending on the model with others like Canon,
Epson, Lexmark etc. Canon were very late to recognize
that Linux was worth supporting. Some multifunction
printers might seem to work OK but the drivers may not
be available for the scanning features.
Many Linux distros are made available on a “live” or
self-booting CD or DVD for trial purposes. If you decide
you like one, there is an icon on the desktop to enable
you to click to install that system. An installed system
will work much faster than the live disk version. You
may need help to set up a dual booting Windows and
Linux installation.
If you decide that minimal use of Linux for safe
browsing or banking is all you require, instead of a live
disk, you can install a particular Linux distro on a self
booting flash drive. You may have to reconfigure the
bios so that the computer boots from the flash drive.
Using a flash drive version of Linux also gives you the
opportunity to store data on it – something you cannot
do with a live disk version. A small “mini” Linux system
on a bootable 4 GB flash drive would enable you
perform banking operations securely and save receipts
or statements to a data folder on the flash drive for
subsequent printing which might be on another
computer.
Choice of “the best” distro depends on what you want
to do with your computer and how comfortable any
specific distro feels. Its also nice not to be too
adventurous and lock yourself into a distro that puts
you out of reach of friends or other computer club
members who can provide advice or help when you
need it.
The best final advice regarding Linux is try it before you
“buy” it. Don't confuse yourself with too much reading
about it before you try it. You didn't do that with
Windows, did you?
Remember its legal and its free!
Come and play with the Penguins.

calls to family and friends in distant places or overseas
at very little cost using your broadband internet
connection?
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Jean's Jottings
SCCC Website (http://www.sccc.org.au)

Membership Sign up

Under the heading Blogs and Articles the drop down
lists Open Office. Here there are a number of tutorials
specific to Open Office. A number of these are listed
below. Paste the link to the Blog in the Browser
Address Bar to open the Blog

Members Home Page

Title of Blog

Members Computers for Seniors

Link to Blog
(Paste into
Address Bar)

Text in a Circle
Open
Office
(Spreadsheets)
Background

Browser

Members Bits'N'Bytes Ezine
Members Forum
Members Free Windows PC Software
Members Open Office Tutorials
Members Macintosh Tutorials

http://sccc.org.au/archi
ves/2534

Members Gimp Videos
Members Website Design Group

Calc http://sccc.org.au/archi
Adding ves/2508

Colour to every second line
Fonts in Open Office
Open
Office
(Spreadsheet)
Column Labels

http://sccc.org.au/archi
ves/2496
Calc http://sccc.org.au/archi
Freeze ves/2457

(headings)
Inserting Lines in Open http://sccc.org.au/archi
Office Writer Documents Part ves/2430
of the way across a page
Inserting Lines in
Office Documents

Open http://sccc.org.au/archi
ves/2417

Saving
Document http://sccc.org.au/archi
Automatically in Open Office ves/2346
Paste Special Icon on Tool http://sccc.org.au/archi
Bar in Open Office
ves/2245
Open Office – How to http://sccc.org.au/archi
Change the Default Font ves/2218
Typeface and Size of Font

SCCC Web Site Members Only Area
The Members Only Area of the Club Web site offers to
members who have registered as a Member a lot of
valuable information. Listed in the Members Only Drop
Down list -

Find a Toilet wherever you go
The Federal Government has created an Australian
Public Toilet map (http://www.toiletmap.gov.au/) which
is also an app. It means you can plan your stops using
your computer from home – or simply agree to using
your location on a smartphone and be told the three or
four closest toilets in the blink of an eye. The site has
sections for – Browse, Find, Plan and My Toilets. With
the Trip Planner you can plan a route from nearly any
starting point to any destination in Australia. The
system will identify the quickest route (by road or on
foot) and create a list of nearby toilets.
Ticking 'Remember me' will automatically log you in
every time you visit the Toilet Map on the computer and
display your toilets, places and searches. You will be
able to see toilets, places and trip plans that you have
saved from previous visits to the site.
You can then select only those toilets that you require
and create a report which you can print for future
reference, save to your My Toilets account, download to
your GPS device or send to a friend.
The site can also find the nearest caravan dump points
to your location - up to the five closest dump points by
distance - by entering a street address.
The map is available on any mobile phone with an
Internet browser. Go to m.toiletmap.gov.au on your
phone to be automatically directed to the mobile site.
The Map is also available for Apple's iPhone. Just go to
the App Store on your iPhone or use iTunes to
download the National Public Toilet Map App. It's free.
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Tech Tips – Bill Maxwell
Keyboard shortcuts for moving faster in
Windows 7.

deleted and any text to the right will be moved. Just
the opposite of the Enter Key.

Some of these will also work in XP and Vista.

The Delete Key will delete text to the Right of the
insertion point.

These short cuts involve using the Windows Key in
conjunction with a second key to open a Windows
Feature or program. The Windows key is located
between the Ctrl and Alt keys on the lower left side of
your computer.
Windows Key by itself will open the Start Menu
Win + E will open COMPUTER.

The Home Key will move the insertion point to the
beginning of the line and will not alter any text.
Ctrl + Home Key will move the insertion point to the
beginning of the document.
The End Key will move the insertion point to the end of
the line.

Win + R will open the RUN dialogue Box
Win + Break will open System page

Ctrl + the End Key will move the insertion point to the
end of the Document.

Win + M will Minimize all Windows
Win + Shift + M will restore all minimized Windows

Page Up and Page down. Just as the name implies.

Win + D Show/Hide Desktop. Basically the same as Win
+M

There is another key on the keyboard that causes all
kinds of problems and it is the Insert key.
When Insert is on and you place the insertion point in
the middle of a line of text and start typing the text to
the right will be pushed along. If the Insert function is
off the text to the right of the cursor will be replaced
with what you type. Sometime this is called the
Overtype mode.

Here are some using the ALT key.
ALT + F4 will close the current window and if no
windows are displayed will open the Shut Down
Windows dialogue box.
ALT + ESC will cycle between open programs in the
order they were opened.

In Word 2007 and 2010 Click on the Microsoft Office
Button in the upper left corner of Word. Then at the
bottom of the dialogue, Click Word Options. In the Left
Pane, click Advanced. Under Editing Options select or
clear the Use Overtype Mode. There is also a tic for
allowing the insert key on the keyboard to control
overtype mode.

ALT + PrtScn will take a Screen Shot of the active
Windows and places it on the Clipboard.
Here are some using the Ctrl key:
Ctrl + A – Selects all items
Ctrl + C – Copies the selected item
Ctrl + X – Cuts the selected item and places it in the
Clipboard.
Ctrl + V – Pastes the selected item previously copied.
Ctrl + Z – UNDO
Here are some tips when you are typing a letter:
The four arrow keys on the keyboard will position the
text insertion point without changing any text.
The Enter Key will move the Insertion point to a new
line. Any text to the right of the insertion point will also
be moved.
The Backspace key moves the Insertion point back one
space. Any text to the left of the insertion point will be
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Raffles
THE LAST SCCC RAFFLE WAS DRAWN THURSDAY 09 February 2012 AT BUDERIM using the Random
Number Generator
The prize was was an Asus Eee X101H PC, designed to be thin and lightweight for maximum portability. It was
a white model with a 10.1 inch screen and has Windows 7 Starter. It has a five hour battery life.
The lucky winner with ticket number 279 was Ron Button. The ticket was bought at a Buderim Meeting.
Thank you to the members who supported this raffle and to the members manning the desks and selling tickets
in the raffle.

NEXT RAFFLE TO BE DRAWN SATURDAY 10 MARCH 2012 AT Caloundra
Following the popularity of the recent raffles when prizes have been a Kindle Book Reader, another Kindle is the
prize for this raffle.
This one is a Kindle Keyboard, Free 3G + Wi-Fi (3G works globally) 6inch Display with USB Cable. Additionally
there is a Kindle Lighted Black Leather Cover.
Tickets will be one dollar each and available at all meetings to day of draw.
Remember buying of tickets is voluntary

RAFFLE TO BE DRAWN THURSDAY 12 APRIL 2012 AT BUDERIM
Watch for details in the April edition of Bits'N'Bytes and the Weekly Bulletin to be published 12 March 2012.
Tickets will be one dollar each and available at all meetings from 15 March 2012 until the draw on 12 April 2012
Remember buying of tickets is voluntary.

Any ideas for future Raffle prizes would be welcome.
Please see Committee member Jim McGregor or Jean Lear
at a meeting or email your ideas to sccc@internode.on.net
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Corporate Members
Help with Computers

Peter Daley

Andrew Hadland Diploma ICT
Phone 5491 8645
•
•
•
•
•

Help with all aspects of Computer
Functions
Tuition – Emails – Scanning – Video
Editing
Burning CD's / DVD's – Backups
Protection Anti Virus – Spyware – Firewall
Internet – ADSL Setup

Computer Repairs and Upgrades for
Windows and Linux. Data Recovery,
Computer and Internet Training and
Setup. Home Entertainment and Hi Fi
systems setups and advice. Custom built
computers, all computer systems are
tested before pickup. Award Winning
Web Page Designer!
E-mail: ( Peter Daley)...

Computer - Repairs - New Systems

PH 0754913279
| Free Books | | Links | | E-mail |

Welfare Officer
Sunshine Coast Computer Club
Phone 54925443 Email
gregalach54@gmail.com
If you are ill or incapacitated or know of a
club member who needs some assistance or
would like to hear from the Club
contact our Welfare Officer Marie McGregor

Find Your Membership Number
Do you read your Bits'N'Bytes each month? Find your membership
number hidden somewhere in one of the pages and win five free tickets
in the current raffle.
The membership number will be chosen at random and will appear as a
four digit number within the text of the magazine and may be on any
page. If your membership number has 1, 2 or 3 digits, it will be shown
with leading 0s.
Do not forget to thoroughly scrutinise every magazine for your membership number hidden within the text of
articles each month.
The number is placed in the 8672 middle of a sentence like this!
Start looking now! The lucky membership number is hidden somewhere in this month's edition. Is it yours?
When you find your number contact the club by email at editor@sccc.org.au or phone 54921005 to claim your
prize. You are allowed 60 days from the publication date to claim your prize. Otherwise, the prize is forfeited!

Page 13

November 2011

Bits'N'Bytes

Classified Ads
Classified Advertisements in Bits'N'Bytes - Editorial Policy is that B'N'B Classified Advertisement 1. Are for the use of members only.
2. Items must not be of a business or commercial nature.
3. Items submitted should be limited to a few items - no huge garage sale lists please!
4. Items should preferably be relevant to computers, graphics, video, audio, electrical or electronic hobbies
etc. Adverts for other types of household goods will be accepted only if there is sufficient room for them.
5. Ads should preferably be forwarded direct to editor@sccc.org.au or phoned in to 54913279.
6. The Editor reserves the right to reject or edit any material .Editor reserves the right to reject or edit

FOR HIRE OR LOAN
The Sunshine Coast Computer Club owns data
projectors, laptops, external DVD burners, scanners,
digital cameras, etc.

Members you can
advertise your
unwanted items
here

This equipment is available for hire or loan to members
when it is not required by the club for meetings and
presentations.
Contact your club if you need to borrow or hire
equipment.

See notes above

Email: sccc@sccc.org.au
Telephone: 0754921005

Australian Seniors Computer Clubs
Association (ASCC Newsletter
The Sunshine Coast Computer Club Inc is a member of
the Australian Seniors Computer Clubs Association –
(ASCCA).
ASCCA issues a Monthly Newsletter, The July 2011
Newsletter may be viewed at - http://www.ascca.org.au
(Click on ASCCA's latest newsletter) or a hard copy is
available for reading at the Caloundra, Buderim and
Yandina Meetings.

SCCC Web Site
http://www.sccc.org.au
To access the 'Members Only' area of the web site,
members must be registered.
Enter the link
http://sccc.org.au/membership-signup
into your web browser and follow the instructions
to get registered
See the Web Forum User Guide in the
October Edition of Bits'N'Bytes

Place Your Classified Ad on this page.
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Item (Prices include GST)

Number

Bits'N'Bytes Ezine Archives CD - June 1998 to December 2010.
Bits'N'Bytes Ezine Archives CD – trade in your old copy.

@ $10 each
@ $5 each

Multimedia CD - Clip Art, Animations, Midi and Wav files and
background colours to add to cards, emails etc. Multimedia CD
Upgrade (With old version CD returned)

@$10 each
@ $5 each

Postage (for one or more CDs)

Cost

$3.00

Post to : SCCC, Post Office Box 384, Caloundra
Enclosed
Cheque / Money Order / Cash

4551
Total

Surf Watch - Members Web Sites...Submit Yours

Member
Peter Daley

Very Useful Links
http://www.ozemail.com.au/~vital1/lstlinks.htm

Peter Daley

Fantasyland Creations http://www.ozemail.com.au/~vital1/

Peter Daley

Daley Positive Personal Development
http://www.ozemail.com.au/~vital1/freebks.htm

Jay Leboutillier

Website Design Centre http://www.websitedesigncentre.com.au/

Technologypals

Corporate member http://www.technologypals.com.au

Bill Maxwell

IT Knowledge Base for Seniors http://it.flexinet.com.au/

Your Committee
President

Peter Daley

5491 3279 (VOIP)09134402

Vice President

Peter Dodwell

5438 7675

Secretary

Marie McGregor

5492 5443

Treasurer

Chris Phillips

5445 6323

Administration Co-ordinator

Jean Lear

5492 1151

Committee

Tom Bray

5479 3149

Committee

Morry Phillips

5491 1148

Committee

George Lupsa

5445 3850

Committee

Jim McGregor

5492 5443

Committee

Ian Smyth

5491 9139

Committee

Andrew Hadland

5491 8645

Committee

Don Wallace

0401 093 692

Committee

Judy Smith

5438 7675

Club Intranet
The Club Intranet is available at all meeting venues. It is packed with up to date free software, tutorials and back
issues of Bits'N'Bytes. Access it from any networked computer at the venue.
Type In your browser address bar:192.168.2.222 At both Buderim and Caloundra and Yandina when
available.
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SCCC Membership Application/Renewal Form
Applications can be posted to SCCC Inc., P O Box 384, Caloundra, 4551
or presented at a meeting
I wish to apply for membership
I wish to renew my membership

Name(s):

Address:
City:

Postcode:

Phone:
Email:
I will collect my membership card from Caloundra

Buderim

Yandina

Membership fees include the electronic version of the club
magazine.

Amount

Individual

$35

Family

$45

Corporate (Includes a monthly advertisement in the club magazine)

$60

Junior (Under 18 Years of Age)

$20

For the additional cost of $12 you may subscribe to a printed and posted
paper version of the club magazine.
Magazine subscription

$12
Total Enclosed $

Signature:
If after joining you don't receive your magazine within one month,
please contact the Club.
SCCC Office Use
Date Paid:

Amount: $

Receipt Number:

Membership Number:

Signed:

Nominated:
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